
Android Applications with HTML5/JavaScript
GuideBook

開発ツールのインストールについて

開発の手順を確認しよう

アプリケーションのデバッグ方法

APKファイルの書き出しと配布

HTML/JavaScriptのデバッグ方法

Chapter02では、Androidアプリを開発するための環境を整備していきます。必要な

ソフトをインストールするとともに、デバッグの方法なども確認しておきましょう。ま

たアプリを公開するための手続きについても紹介します。

CHAPTER_02
はじめてのAndroidアプリ

Android Marketへの登録方法

アプリのアイコンを変更するには
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開発ツールのインストールについて

Android Application 
with HTML5/JavaScript
Guide Book

CHAPTER_02

Chapter02では本書の開発で使用するソフトウェアをインストールして環境を構築していきま
す。使用するソフトウェアは以下の通りです。

・Google Chrome … Webブラウザ（HTML/JavaScriptのテストに使う）
・Aptana  … HTML/JavaScriptの開発環境
・Android SDK … Androidの開発に必要な開発キット
・jsWaffl  e  … HTML/JavaScriptをAndroidプロジェクトに変換するフレームワーク

上記、すべてのアプリケーションはオープンソースで開発されており、無償で入手することがで
きます。これは、Androidの透明性をよく表わしていると言えます。

G o o g l e  C h r o m e
AndroidのHTML/JavaScriptのエンジンは、パソコンのWebブラウザ「Google Chrome」と
共通する部分が多く、特にHTMLのレンダリング部分には、WebKit（ウェブキット）が採用されて
います。そのため、実際にAndroid端末に転送する前に、Google Chrome上でだいたいの表示
や実行の様子を確認することができます。これにより、効率的にアプリの開発を行うことがで
きます。

STEP_01

Google Chromeは以下のURLからダウン
ロードすることができます。URLにアクセス
し、［Google Chromeを無料ダウンロード］
のボタンをクリックします。

Google Chrome のダウンロードサイト
http://www.google.com/chrome/intl/ja/
landing.html?hl=ja

||||| Google Chromeのインストール ||||||||||||||||||||||||||||||||||||||||||||||||||||||||
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STEP_02

ライセンスの確認画面が表示されるので、確
認したら［同意してインストール］をクリック
すると、Google Chromeがインストールされ
ます。

Google Chromeにはさまざまな機能があり、HTML/JavaScriptの開発に便利なデバッグ機能
を備えています。デバッグしたいHTMLファイルをChrome上にドラッグ＆ドロップして表示し
たら、右クリックしてポップアップしたメニューにある［要素を検証］をクリックします。すると、
HTML要素がツリー構造で表示され、直感的にHTMLの構造を調べることができます。

| 図 02-001 |  Google Chromeでのデバッグ

||||| Google Chromeでデバッグを行うには |||||||||||||||||||||||||||||||||||||||||||||||
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| 図 02-002 |  

また、［Scripts］のタブをクリックすると、スクリプトのデバッグ専用画面になり、画面の左側に
ある行番号をクリックすることでブレークポイントと言って、途中で実行を中断して一行ずつ実
行することができます。また、ブレークポイントで実行を中断すると、その時点の変数の内容を
確認したり、関数の呼び出し履歴を確認することができます。こうしたデバッグ支援機能がはじ
めから備わっているので、HTML/JavaScriptのデバッグを非常に手軽に行うことができます。

A p t a n a  S t u d i o  2と必要プラグイン
Androidの開発においては、Javaの統合環境Eclipseを使うのが一般的ですが、本書では、
HTMLやJavaScriptを主に扱いますので、EclipseをWeb開発向けにチューニングしたAptana 
Studioを利用してAndroidの開発を行っていきます。もちろん、EclipseにAptanaプラグインを
インストールする方法もありますが、ここでは、便利なAptana Studioを使ったセットアップの方
法を紹介します。

STEP_01

Aptana Studio 2は、下記AptanaのWebサ
イトからダウンロードすることができます。
Windows/Mac OS X/Linuxで動作可能で
す。
「DOWNLOAD APTANA STUDIO 2」ボタ

ンをクリックしてインストーラ－をダウンロー
ドします。

Aptana Studio 2のWebサイト
http://www.aptana.org/products/studio2

||||| Aptana Studio 2のインストール |||||||||||||||||||||||||||||||||||||||||||||||||||||||

Android Application with HTML5/JavaScript Guide Book028

は
じ
め
て
のA

nd
roid

ア
プ
リ

#02



STEP_02

親切なインストーラーが用意されていますの
で、ダウンロードしたインストーラーをダブル
クリックして実行します。

STEP_03

指示に従って［Next］ボタンを数回クリック
することでインストールを完了させることが
できます。

||||| 必要なプラグインのインストール |||||||||||||||||||||||||||||||||||||||||||||||||||||||

STEP_01

Aptana Studioは素の状態でも、HTML/
CSS/JavaScript/XMLの基本的な機能を
備えているのですが、プラグインを追加する
ことで、より強力な開発環境を手に入れるこ
とができます。

プラグインを追加するには、Aptana Studio
のツールバーから、パズルのピースのアイコ
ンを持つ「Install Aptana Features...」をク
リックします。
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STEP_03

その後、インストールに必要なパッケージが
列挙されますので、内容を確認して、チェック
を入れて［Next］ボタンをクリックします（例
えば、バージョン違いのプラグインがいくつ

か列挙されたりしますので、同じ名前のパッ
ケージが列挙されたなら、最新のパッケージ
の方にチェックを入れます）。

STEP_02

すると、Customize Aptana Studioのダイア
ログが表示されます。このダイアログで、必
要と思える項目にチェックしたら［Install］ボ

タンをクリックします。ここでは「JavaScript 
Libraries」にチェックを入れています。
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TIPS // 02-001

Aptanaでは、アプリケーションを作る時、はじめ
にプロジェクト（Project）を作ることになります。
プロジェクトでは、アプリケーションを作る上で必
要となるソースコードや素材ファイルなどをまとめ
て管理することができるのでとても便利です。

ワークスペースについて
さて、Aptanaでプロジェクトを作成すると、プロ
ジェクトは、ワークスペース（Workspace）と呼ば
れる指定ディレクトリ以下に配置されていきます。
そのままプロジェクトを作り続けると、ワークス
ペース内にプロジェクトがたくさんできて、管理が
大変になってしまいます。

そこで、ワークスペースを切り替えて使うことに
なります。ワークスペースを切り替えるには、メ
ニューから［File > Switch Workspace］で行うこ
とができます。新しいワークスペースを作るには、
［File > Switch Workspace > Other...］をクリッ
クします。必要がなければ、切り替えずにそのまま
使用してください。

ワークスペースを扱う上での注意点
ワークスペース内のプロジェクトは、Aptanaによって管理されます。そのため、Windowsのエクスプロー
ラー上で勝手にプロジェクト用のフォルダを作成したり、既存プロジェクトを削除しても、Aptanaの
Package Explorerには反映されません。かえって面倒なことになるので、プロジェクトの作成、削除、変
更は、Aptana上で行うようにしましょう。

加えて、本書の手順に沿って、外部ソースコードからプロジェクトを作成する場合（Create project from 
existing sourceをチェックした場合）、プロジェクトで使用するソースコードは、ワークスペース以下にコ
ピーされませんので、プロジェクトを作ったからといって既存のソースコードを削除しないように注意しま
しょう。

プロジェクトのインポートについて
上述の注意点の通り、Windowsのエクスプローラーを使って、自分のワークスペースに他人が作ったプロ
ジェクトをコピーしたとしても、プロジェクトの存在を自動では認識してくれません。

例えば本書のサンプルプロジェクトを使おうと思う場合も同じです。P.10で紹介している手順に沿って、
既存のソースからプロジェクトを作成する必要があります。

Aptanaのプロジェクト管理について

Package Explorerを使ってプロジェ
クト内のファイルを管理できます
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Androidの開発に必要なのは、Androidの開発者サイトで提供されている、Android SDKです。
これには、コンパイラからデバッグ用のエミュレーターまで開発に必要なツールが一式用意さ
れています。ここではそのインストール方法を紹介します。

A n d r o i d  S D K

STEP_04

すると、必要なファイルがダウンロードされ
ますので、紅茶を片手に音楽を聴きながら、
しばらく待ちましょう。その後、インストール
前にプラグインのライセンスが表示されます

ので、「I accept the terms of the license 
agreements」（ライセンスに同意する）に
チェックして、［Finish］ボタンをクリックしま
す。以上でAptanaのセットアップは完了です。

STEP_01

Android SDKを利用するには、Javaの開発
環境であるJDK（Java Development Kit）が
必要となります。Android SDKをセットアッ
プする前に、JDKをインストールします。
下記JDKのダウンロードページを開き、［JDK
ダウンロード］のリンクをクリックします。

JDKのダウンロードページ
ht tp : // java .sun .com/javase/ja/6/
download.html

||||| JDKのインストール ||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||
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STEP_02

次にプラットフォームの選択画面が出るの
で、［Platform］のプルダウンメニューからイ
ンストールするプラットフォームを選択して
［Continue］ボタンをクリックします。

STEP_03

続いて、ファイルが表示されるのでリンクを
クリックしてダウンロードを行います。ファイ
ル名はバージョンアップにつれ変更になるの
で、画面と異なる場合があります。

STEP_04

ダウンロードできたら、ダウンロードしたJDK
のインストーラーをダブルクリックして実行
します。
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STEP_05

インストールする機能やインストール先の確
認画面です。特にこだわりがなければそのま
ま［次へ］をクリックします。他の画面も特に
希望がなければそのまま［次へ］をクリックし
て進みます。

STEP_06

JDKのインストールが完了した場面です。

||||| Android SDKのインストール ||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||

STEP_01

Android SDKは複数OSをサポートしていま
す。ここでは、WindowsにAndroid SDKを
インストールする手順を紹介しますが、Mac/
Linuxでもほとんど同じ流れになります。
はじめに、Android SDKをダウンロードして
おきましょう。このSDKは、ツール（エミュレー
タなど）やドキュメント、サンプルなどを含ん
でいます。下記サイトにアクセスし、ここでは
ZIPファイルをダウンロードします。

Android SDK のダウンロード
http://developer.android.com/intl/ja/sdk/
index.html
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STEP_02

ダウンロードしたら、解凍ソフトでZIPファイ
ルを解凍します（Windowsであればファイル
を右クリックして［すべてを展開］を選択する
など）。そして、Windowsなら、分かりやすく
Cドライブなどに「android-sdk-windows」な
どの名前でコピーしておきます。ここでは便
宜的に、c: ¥android-sdk- windowsにコピー
したものとして進めます。

TIPS // 02-002

Android SDKがサポートするOS

Windows XP（32-bit）、Vista（32/64ビット）、
Windows 7（32/64ビット）
Mac OS X 10.5.8 以降（Intel Macのみ）
Linux （Linux Ubuntu Hardy Heronで
動作確認済みとのこと）

TIPS // 02-003

解凍したファイルのコピー先

コピー先までのパスに日本語や空白スペース
が入るとうまく動かない場合があるようです。
なるべくドライブの直下などにコピーしてくだ
さい。

STEP_03

そして、解凍したアーカイブの中に含まれる、
「SDK Manager.exe」をダブルクリックして
実行します。このSDK Managerを使うと、
Androidの各バージョンをセットアップするこ
とができます。

STEP_04

SDK Managerのパッケージのインストール
画面が出たら、右側［Install］ボタンの右上
にある［Accept All］（すべてに同意する）を
選んで、［Install］ボタンをクリックします。
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A n d r o i dプラグインの導入
次に、Android プラグイン（ADT）をインストールします。ここでは、Aptanaにプラグインを導
入したものとして説明します（Eclipseを使った場合でも手順はほとんど同じです）。

STEP_01

はじめに、Aptanaを起動します。
Windowsでは、［すべてのプログラム > 
Aptana > Aptana Studio 2.0］をクリックし
て起動します。

TIPS // 02-004

何かしらの問題で、SDK Managerで正しくインストールが完了しない場合があります。その場合、一度イ
ンストールをキャンセルして、SDK Managerの左側のリストから「Settings」を選び、「Force https://... 
sources to be fetched using http://...」にチェックを入れます。

SDK Managerでエラーが出る場合

STEP_02

メ ニ ュ ー の［Help］よ り［Install New 
Software...］をクリックします。

Android Application with HTML5/JavaScript Guide Book036

は
じ
め
て
のA

nd
roid

ア
プ
リ

#02



STEP_03

Installダイアログが表示されたら、画面右上の［Add...］ボタンをクリックします。

STEP_04

Add Siteのダイアログが表示されたら、そこ
にAndroidプラグインのインストール用サイ
トを記入します。右の値を記入してください。

Name：Android Plugin
Location：https://dl-ssl.google.com/
android/eclipse/

STEP_05

サイトにAndroidプラグインを追加すると、イ
ンストール可能なプラグインの一覧が表示
されます。こここでは、［Developer Tools］
にチェックを入れます。そうすると、その下

位に位置する、Android DDMSとAndroid 
Development Toolsにもチェックが入りま
す。チェックしたら［Next］ボタンをクリック
します。
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STEP_06

インストールするアイテムが表示されますので確認して［Next］ボタンをクリックします。

STEP_08

インストールが開始されますので、しばらく作業が終わるのを待ちます。

STEP_07

プラグインのライセンスが表示されます
の で［I accept the term of the license 

agreements］（ライセンスに同意する）を
チェックして［Finish］ボタンをクリックします。
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STEP_10

インストールが完了すると再起動を求められますので、［Yes］をクリックして、Aptanaを再起動
します。

STEP_09

途中で、セキュリティの警告（Security Warning）が出ますが、今回は問題がありませんので、
［OK］をクリックして処理を継続します。

STEP_11

次に、Android SDKとADTプラグインを結び
つける作業を行います。メニューの［Window 
> Preferences］をクリックします。

STEP_12

設定画面（Preferences）が表示されたら、
左側のリストから［Android］をクリックし
ます。すると、右の図のような画面が表示さ
れるので、右上にある［SDK Location］に、
Android SDKのインストールパス（ここでは
C: ¥android-sdk-windows）を入力します。
入力したら右下の［Apply］ボタンをクリッ
クします。すると、インストールされている
Androidのバージョンが表示されます。
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仮想デバイスの作成
Android SDKには、Androidのエミュレーターが含まれています。ここでは、エミュレーター上
で動作する仮想デバイスの作り方を紹介します。仮想デバイスではAndroidのプラットフォーム
バージョンや画像サイズなど自由に設定することが可能です。そのために、AVD Managerを
使います。AVDとはAndroid Virtual Deviceの略で、Android仮想デバイス管理ツールを意味し
ています。

STEP_01

Aptana Studioを起 動して、メニューか
ら［Window > Android SDK and AVD 
Manager］をクリックします（あるいは、

Android SDKに含まれる「SDK Manager.
exe」を起動します）。

STEP_02

そして、画面の左側から［Virtual Devices］をクリックします。

STEP_03

画面の右上にある［New...］ボタンをクリックします。
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STEP_04

以下を参考に仮想デバイスの設定を記入し
ます。

パラメータ パラメータの意味 ここでの記入例

Name AVDの名前 Test1.6

Target Androidのバージョン Android 1.6 - 
API Level 4

SD Card SDカードのサイズを
指定 Size: 512 ［MiB］

Skin 画面のサイズ Built-in: Default
（WVGA800）

Hardware 搭載するハードウェア （STEP_05を
参照）

STEP_05

一般的なスマートフォン端末では、ハードウェ
アとして、カメラやGPSをサポートしていま
す。Hardwareの項目にある［New］ボタンを
クリックして、必要と思える機能を追加しま
す。項目が記入できたなら、［Create AVD］
のボタンをクリックします。

STEP_06

作成した［Test1.6］を選択したら、右側の［Start...］ボタンをクリックします。すると、Android
のエミュレータが起動します。
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TIPS // 02-005

マシンの性能によりますが、仮想デバイスの初めての起動時には、非常に時間がかかります。［Start］ボタ
ンを押してから根気強く起動を待ちましょう（Windowsのタスクマネージャーで［プロセス］のタブを
確認すると、emulator.exeという名前のプロセスが起動しています）。

エミュレータの起動に時間がかかる場合

STEP_07

メニュー画面が表示されたら、画面右側にあ
るキーボード上部の［MENU］ボタンをマウ
スでクリックすると、Androidのホーム画面
が表示されます。

STEP_08

Android端末を終了させるには、キーボード
の上方、右側にある赤い終話のボタンを長押
しし、［Power off ］あるいは［電源を切る］の
メニューをタップします。
仮想エミュレーターでは、通常のウィンドウ
と同じで右上の［x］ボタンをクリックして終
了させることができます（エミュレーターの
便利なところです）。
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TIPS // 02-006

作ったばかりの仮想マシンは、言語の設定が「英語」
になっています。そこで、日本語に設定しておきましょ
う。

ホーム画面で、［MENU］ボタンを押して、［Settings 
> Locale & Text > Select locale > Japanese］を
タップします。

仮想マシンの言語を日本語にする

j sWa f f l eのインストール
jsWaffl  eは、HTML/JavaScriptを使ってAndroidアプリケーションを作るためのフレームワーク
で、簡単にAndroidプロジェクトのひな型を生成することができます。jsWaffl  eは、Webブラウザ
から簡単にインストールが可能です。jsWaffl  eのダウンロードページへ行き、インストールボタン
をクリックするだけです。では、一つずつ手順を確認していきましょう。

STEP_01

まずは、jsWaffl  eのダウンロードページを開
きます。［Download］ボタンを押して、次の
ページへ進みます。

jsWaffl  e ダウンロードページ
http://d.aoikujira.com/jsWaffl  e/download.
php
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STEP_02

そして、画面中央にある［INSTALL NOW］
というボタンをクリックします。

STEP_03

もし、Adobe AIRのランタイムがインストー
ルされていなければ、右のような画面が出ま
す。［はい］をインストールしてください。既に
インストールされていれば、「このファイルを
開く、または保存しますか？」という確認ダイ
アログが出るので、「開く」ボタンをクリック
してください。

STEP_04

すると、右のような確認画面が表示さ
れます。発行者が不明になっているか
もしれませんが、アプリケーションが
「jsWaffl  eForAndroid」と表示されていること
を確認したら、［インストール］ボタンをクリッ
クします。

STEP_05

ここで、インストールの環境設定の確認画面
が出ます。問題がなければ、そのまま［続行］
をクリックしてください。
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STEP_06

はじめて、Adobe AIRをインストールする際
には、ライセンスへの同意ダイアログが表示
されます。ここでは、ライセンスを一読の上、
［同意する］のボタンをクリックします。

STEP_07

以上の手順で、jsWaffl  eのインストールが行
われます。少しの間、待っているとインストー
ルが行われ、終了すると、jsWaffl  eが起動し
ます。
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開発の手順を確認しよう

Android Application 
with HTML5/JavaScript
Guide Book

CHAPTER_02

Aptana/Android SDK/jsWaffl  eのインストールが終わっているとして、ここでは、開発手順を
紹介します。jsWaffl  eは、Androidの開発において、HTML/JavaScriptを動かすためのフレーム
ワークとなっています。そのため、はじめに、jsWaffl  eで Androidプロジェクトのひな型を作り、
それを、Aptanaにインポートすることで開発を始めることができます。

Aptanaにプロジェクトをインポートしたなら、assetsというフォルダに含まれるHTMLファイル
を書き換えたり素材を足したりして編集を行います。そして、Aptanaでプロジェクトを実行する
と、実機やエミュレータ上で動作を確認できます。

1．jsWaffl  eでAndroidプロジェクトのひな型を作る
2．Aptanaでプロジェクトのひな型をインポートする
3．assetsフォルダの中にあるHTMLを編集する
4．Androidアプリとして実行する
5．動作を確認する
6．手順3に戻ってアプリが完成するまで繰り返す

開発のワークフローを概観する

具体的に開発手順を確認していこう

STEP_01

では、ここから、実際に手を動かして開発
手順を確認していきましょう。OSのアプリ
ケーション一覧から、jsWaffl  eを起動します。
Windowsなら、スタートメニューから［すべて
のプログラム > jsWaffl  e］をクリックします。
前の項目でインストール後、起動したままの
人はSTEP_02へ進んでください。
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STEP_02

jsWaffl  eが起動したら、プロジェクト名やパッ
ケージ名を記入します。ここでは、下のように
値を入力してください。ProjectNameにはア
プリケーションの名前を、PackageNameに
は他と重複しない名前（通常はWebサイトの
ドメイン名を逆さにしたもの+アプリ名）を指
定します。OutputDirはマイドキュメントなど
を指定します。

ProjectName：Hello
PackageName：com.example.Hello
OutputDir：<マイドキュメントのパス>Hello

TIPS // 02-007

OutputDirのパス

こ のOutputDirに は、Aptana（Eclipse）の
Workspace以外のパスを指定してください。
Workspace内にひな型を生成した場合に
は、操作の手順が異なってしまいます。

STEP_03

記入が終わったら、［Make Project］ボタン
をクリックします。すると、フォームに記入し
た値に応じた、Androidプロジェクトのひな
型が生成されます。生成が終わると、そのディ
レクトリが起動します。
jsWaffl  eと開いたディレクトリは閉じてしまっ
て構いません。

STEP_04

次に、Aptana（あるいはEclipse）を起動し
ます。Windowsなら、スタートメニューから、
［すべてのプログラム > Aptana > Aptana 
Studio 2.0］をクリックします。

047

は
じ
め
て
のA

nd
roid

ア
プ
リ

#02

| #02-02 | 開発の手順を確認しよう 



STEP_05

そして、新規プロジェクトを作成します。
Aptanaが起動したら、メニューから［File > 
New > Project...］をクリックします。

TIPS // 02-008

Aptanaのメニューに関して

Aptanaの設定により、若干メニューの項目が
変わる可能性があります。メニューの［File］
以下に表示される［Aptana Project］をクリッ
クすれば、STEP_05 ～ 06と同じ動作
になります。

STEP_06

［New Project］のダイアログが表示された
ら、［Android > Android Project］を選択状
態にして、［Next］ボタンをクリックします。
すると、［New Android Project］のダイアロ
グが表示されます。

STEP_07

ここで、先ほど作成した、jsWaffl  eのひな型
を元にして新規プロジェクトを作成します。
Project nameの下側、Contentsの囲みから、
［Create project from existing source］を
チェックします。それから、Locationの部分
に、jsWaffl  eで生成したプロジェクトのパス
を選択します。上部に警告が出ますが、無視
して進めてください。プロジェクト名が自動
的に設定されたら、［Finish］ボタンをクリッ
クします。
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TIPS // 02-009

この作業の前に、Workspaceに、Android SDKのパスを設定してある必要があります（P.39参照）。

Android SDKのパスに注意

STEP_08

Package Explorerでプロジェクトを選択し、
メニューのデバッグボタンをクリックして、
jsWaffl  eのデモを実行してみましょう。ここで
エラーが表示される場合は、この後の「コン
パイラバージョンの確認」を試してみてくださ
い。

STEP_09

続いて、［Debug As］のダイアログが表示さ
れるので［Android Application］を選択して
［OK］ボタンをクリックします。
すると、Androidのエミュレータが起動しま
す。はじめてエミュレータを起動させる時に
はしばらく時間がかかります。Androidのロゴ
が光っている間は起動中です。じっと待ちま
しょう。

STEP_10

jsWaffl  eのデモが実行されたら、ボタンをク
リックして動作を確認してみましょう。エミュ
レータ上では体験できない機能もあります
が、雰囲気がつかめると思います。もし、パソ
コンとAndroid端末の実機をUSBでつない
でいるなら、エミュレータの代わりに、実機
でアプリケーションが実行されます（詳しく
はChapter02末尾のコラムをご覧ください）。
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STEP_12

ファイル「assets/www/index.html」はアプ
リケーションが実行された時に表示される、
メインアプリケーションHTMLファイルです。

このファイルを、以下のように書き換えて保
存してください。

01 <!DOCTYPE html>

02 <html>

03 <body>

04  <h1>Hello!</h1>

05 </body>

06 </html>

| スクリプト 02-001 |  サンプルファイル:assets/www/index.html

TIPS // 02-010

もし、エラーが出てデモが実行できない場合は、
コンパイラのバージョンが問題になっている場合
があります。その場合は、Package Explorerでプ

ロジェクトを右クリックして［Properties］を選択
し、［Java Compiler］にあるコンパイラのバージョ
ンを1.6に変更してみてください。

コンパイラバージョンの確認（エラーが出る場合）

STEP_11

デモを表示しているHTMLを、自分のHTML
ファイルに差し替えたり、編集することで独
自のアプリケーションを作ることができます。
ここでは、画面にHelloと表示するアプリケー
ションを作ってみます。AptanaのPackage 
Explorerから、 ファイル「assets/www/
index.html」をダブルクリックして開きます。
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STEP_13

書き換えた内容を実行するには、デバッグボ
タンをクリックします。二度目に実行する場
合には、デバッグボタンの右側の▼ボタンか
ら選んで実行することができます。

STEP_14

そして、無事にAndroidエミュレータで実行さ
れると、右記のように表示されます。

jsWaffl  eを使って作ったAndroidプロジェクトのひな型は、以下のようなフォルダ構成になって
います。ここでは、その役割を簡単に紹介します。

| 図 02-003 |  

jsWaffl  eで生成したプロジェクトのひな型

プロジェクトのルートディレクトリは次のような意味を持っています。これは、Javaで作った
Androidプロジェクトの一般的な構成となっています。

j sWa f f l eのフォルダ構成を確認しよう
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